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CHAPTER I
THE TEMPLATES
These templates were created as tools to assist authors in meeting the
formatting requirements as set forth in The Standards for Preparing Theses and
th
Dissertations: 8 Edition. These templates make use of some advanced features that
are only available in Word 2011 or newer versions.
It is very important that all of the following instructions are read before
using these templates. The user should be aware of Word’s many automated settings in
order to make full use of these templates’ capabilities. Also, it is highly recommended
that the user save often and keep multiple backup copies of their work during the
writing process. One of the best methods for organizing drafts is to save each major
revision as its own file so that previous drafts may still be accessed.
There are 5 versions of the Word 2011 Automated Template. Each version
handles a specific layout preference for formatting subheadings and table/figure
title numberings.
Template A provides subheading levels that are distinguished by
formatting, and it numbers tables/figures sequentially (1, 2, 3…)
throughout the document. This is the closest to being APA without
actually being in APA format. Ideal for disciplines in the
Humanities.
Template B provides subheading levels that are distinguished by
formatting, and it numbers tables/figures sequentially by chapter (1.1,
1.2, 1.3…, 2.1, 2.2, 2.3…). This template provides the best utility in
preparing for future reformatting of sections for journal publication. If
you are planning to submit parts of your document as journal articles,
this would be the best choice. Ideal for Humanities and Soft Sciences.
Template C provides subheadings numbered by chapter (1.1, 1.2,
1.3…) and distinguished by subsections (1.2.1, 1.2.2…), and it
numbers tables/figures sequentially by chapter (1.1, 1.2, 1.3…, 2.1, 2.2,
2.3…). This template provides the best utility in cross referencing
between chapters. This template is ideal for very technical documents
such as those typically associated with the Hard Sciences.
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All three meet the formatting requirements of MSU. APA styles are not
supported by these templates.
There are 2 more templates that are available to meet specific departmental
requirements. The College of Education and the Department of Psychology have formal
exceptions to specific formatting requirements on file and Template APA is available to
help affected authors navigate those exceptions. The discipline of Chemistry commonly
makes use of an example style called “Schemes”. Template C with Schemes is
available to help incorporate schemes easily within the template. These last 2
templates are reserved only for those who are required by their department
to incorporate the layout that they provide.
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CHAPTER II
WHAT YOU SHOULD KNOW BEFORE YOU GET STARTED
There are a few tools in Word 2011 that you should know how to use before
starting. It is important that you learn these basic tools and use them throughout the
writing of your document.
Styles and Quickparts
Styles are very important and provide a link between the document and the
formatting. The style gallery is located on the Home ribbon and can be scrolled
through by clicking on the up/down arrows located on the right of the style gallery. In
the templates, the style gallery displays the styles you will need to use in the creation of
your document. You will know a style is linked to your document if the corresponding
style is surrounded by a blue box in the style pane when your cursor is placed on a title
or heading.
Quickparts are shortcuts that can be used to create new chapters, tables, figures
and landscape pages, etc. Quickparts are covered in Chapter 8 (VIII) of these directions.
It is good to familiarize yourself with these before you begin.
Paragraph Marks
Turning on Paragraph Marks allows you to see hidden text, format marks, and
section/page breaks. This is one of the most useful tools in managing the format of a
document, as it allows for a visual inspection of the format of the document. To
activate the Paragraph Marks, you can simply press Control + Shift + 8, or click on
the ¶ icon in the paragraph section of the Home ribbon. Common symbols are as
follows:
¶
=
Hard Return (Any instance of pressing the Enter key)
=

Soft Return (Any instance of pressing Shift + Enter)
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Section Breaks
Section Breaks allow you to divide your document into multiple sections, each
of which constrains certain formatting (e.g., margins, landscape/portrait layout, and
header/footer) to a specific area of the document. For these templates, it is
recommended that only “Section Break: Next Page” be used. To insert a “Section
Break: Next Page”, go to the Page Layout ribbon and click on “Breaks” in the Page
Setup section. The fourth option down is “Section Break: Next Page”.
When inserting a Section Break, the new section will inherit all the properties
of the previous section. So if a page number in the footer was formatted to “Start at
1”, the new section would also “Start at 1” for the page number in the footer. Keep
this in mind when inserting new sections and check to make sure that you
correct/update any format to the margins, landscape/portrait layout, and header/footer
as needed.
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CHAPTER III
PRELIMINARY PAGES
Title Page
The Title is set in a control box.
To enter in a title,
•

click on the current title to highlight the control box

•

click on the tab of the control box (labeled “Title”) to select all of the text
in the control box

•

Type in the title of your document in sentence case (meaning
only capitalize the first word and any proper nouns or
acronyms).

•

If your title is longer than 1 line, just keep typing without using a Hard
Return (pressing Enter)
If you have need for the use of italicized
characters (such as Latin names in Biological Sciences), you will need
to add such formatting after the title is entered.

To add the required italics, you will need to remove the content control box (as
it will only allow 1 text format for its content) by right-clicking on the content control
box and select “Remove Content Control”. This will leave just the text (and the
spacing format) and allow you to now edit specific words’ formatting.
The key advantage to this content control is that once you have entered your
title, it will appear on all appropriate pages that use the title (Approval Page and
Abstract).
If you have a multiple lined title that is not displaying in an invertedpyramid style, you will need to manually add Soft Returns (Shift +
Enter) to force a new line at locations to achieve the invertedpyramid style. These line breaks will be carried over to the Approval
Page as well.
5

Author’s Full Name
This is another content control box like the one for Title. Use the same process
to replace the text with your name (as it appears with MSU's records—check Banner).
This information will automatically be added to all other sections requiring the author’s
name.
Committee
This section is where you will list your committee members. Honorifics should
be listed before the Committee Member’s name, but do not include position (Professor,
Assistant Professor, etc.) or their degree or professional titles (Ph. D, P.E., etc).
Committee member names should match what is listed in the Graduate Faculty listings.
You will list Major Professor(s) first followed by your Committee. If any person also
serves a secondary role, you will list them twice. Your Graduate Coordinator will be
listed next to last and will be followed by your College’s Dean. You have a drop down to
choose your College. Any lines you do not use will be deleted.
•

Professor’s Name, First Middle Last (must match the Graduate School's list of
Graduate Faculty)

•

Role on committee-if applicable. Examples of roles: (Major Professor), (Minor
Professor), (Director of Thesis), (Director of Dissertation), (Committee Member),
(Graduate Coordinator) –only if not a committee member, (Co-Major Professor) –
must have at least two. In the template, a Role listbox is provided so that you can
select the appropriate role.

Type of Document
The type of document (Thesis/Dissertation) is also a content control
box (specifically a list box). Click on the Type of Document control and
select the appropriate document type (either Thesis or Dissertation).
Degree
In the line “for the Degree of <Degree>”, Degree is another content control box
(specifically a list box). Click on the Degree control and select an appropriate degree
type or manually type one in if it is not listed(Master of Science, Master of Arts,
Doctorate of Philosophy, etc.—please verify this information with your Major
Professor or Graduate Coordinator)
Major
In the line “in <Major>”, Major is another content control box. Use the same
method as in Title to replace the default text with your actual Major (please verify
this information with your Major Professor or Graduate Coordinator).
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Department
In the line “Department of …(or possibly College of…-see template
instructions).”, Department is another content control box. Use the same method as in
Title to replace the default text with the actual degree granting department (or college if
lacking such a department). When done the line should read "in the Department of
<your department here>" (or "in the College of <your college here>" for those
obtaining an interdisciplinary degree or degree that is sponsored directly by a College
rather than a Department). Check with your Major Professor or Graduate
Coordinator to verify your department’s current name as it is possible for it to
have changed since you started your graduate degree program.
Graduation Date
Replace the default text (Month Year) with the actual month and year for
graduation. Do not abbreviate the month. The fastest way to do this is to first click
on the word "today" after the calendar appears, then select your graduation date.
Copyright Page
The information on this page should be automatically filled in after you
complete the Title page, except for the year. Simply replace the default text (Year) with
the year of graduation. This page is optional. You should discuss with your Major
Professor the possible merits for copyrighting your work and whether or not it is
needed. If you wish to remove the page, first make sure that your paragraph marks are
turned on. Highlight all of the text on the copyright page and delete it. Also make sure
that you delete the “Section Break (Next Page)” to remove the remaining blank page
from the document.
Abstract
You will need to enter the name of your Major Professor on the appropriate
line after the listing for your Major.
•
•

Click on the text “Select Appropriate Title”
Select one of the listed titles or type an appropriate title for the Chair(s)
of your Committee
• Click the text “Add the name(s) of the person(s) heading your
committee.”
• Click on the tab titled “Major Professor” that appears above the box
• Type or paste the name(s) of your committee chair(s).
• If you have two chairs that hold differing titles:
o Simply copy the first committee chair entry
o After the first committee chair entry, press enter to start a new line
o Paste the copied entry
7

o Complete the new line as done for the first line
o Delete the remaining blank line (if any)
Finally, replace the default body text with your actual abstract. Things to keep in
mind when writing the body of the Abstract:
Theses are limited to 150 words, Dissertations are limited to 350 words.
(This is a requirement set by Masters Abstracts International and
Dissertation Abstracts International and is non-negotiable.). Keywords
are not counted as part of the word limit for abstracts.

Note: the next section that follows after the abstract must start its page
numbering with the lower-case Roman numeral “ii”. This is setup by default in the
Template, but if you delete the Dedication and Acknowledgements page, then the Table
of Contents’ page number formatting must be set to start at “ii”.
Dedication
This page is optional. Simply replace the default body text. If your abstract was
longer than 1 page, then you will need to reformat the page number in the footer to
“Start at ii”. If you do not wish to have a Dedication page, but will have an
Acknowledgements page, simply change the page heading from “Dedication” to
“Acknowledgements” and delete the following acknowledgements page. This will
preserve the page numbering.
Acknowledgements
This page is optional. Simply replace the default body text. If you wish to
remove the Acknowledgements page, but are keeping the Dedication page, simply
remove all of the text on the Acknowledgements page and delete the “Section
Break (Next Page) to remove the blank page.
Table of Contents
The Table of Contents (TOC) is built using Word’s automatic Table of
Contents creator and is formatted to meet the requirements set forth in the MSU
Standards. Nothing will need to be done to this page initially. However, once your
document is complete, you will need to update the TOC. To accomplish this:
•

right-click on the body of the TOC and select “Update Field”

•

Initially (and after altering/adding/removing any titles or subheadings)
select “Update entire table”
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•

This will populate your TOC with your chapter titles and
subheadings, as well as their page number references.

•

The other option, “Update page numbers only”, is useful when
making content changes that may have affected the location of the
referenced text in the TOC.

Always update the TOC before submitting to make sure that all listings and page
number references are accurate.
Note: One possible issue that may occur for Templates A and B is the
failure of the TOC to correctly display certain listings with a dot leader and
page number.
This will only happen with very short subheadings that are less than 0.5”
in length. The reason for this is that each line is set to have a hanging
indent of 0.5” from where the first line of text starts for multi-line
headings. If a heading is shorter than 0.5”, then the automatic Tab after
the heading goes to the hanging indent, rather than to the 6” dot leader
tab. To correct these, place your cursor on the first dot leader and tab
over once.
Also, Word 2010 adds a dot leader and page number reference for the entries
"CHAPTER" and "APPENDIX". Simply delete the dot leader and page number
from both entries after updating.
List of Tables
The List of Tables (LOT) works the same way as the Table of Contents. When
you have finished your document, simply update the LOT in exactly the same way as
the Table of Contents. Always update the LOT before submitting to make sure that all
listings and page number references are accurate
If you do not have any tables in your document, you can just delete this section
(It is recommended that you wait until after your defense, in case an addition of tables is
requested). Simply remove all the text from the page and delete the “Section Break
(Next Page)” to remove the blank page.
List of Figures
The List of Figures (LOF) works the same way as the Table of Contents.
When you have finished your document, simply update the LOF in exactly the same
way as the Table of Contents. Always update the LOF before submitting to make sure
that all listings and page number references are accurate
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If you do not have any figures in your document, you can just delete this
section. (It is recommended that you wait until after your defense, in case an addition of
figures is requested) Just remove all the text from the page and delete the “Section
Break (Next Page)” to remove the blank page.
List of Schemes (only for Template C with Schemes)
The List of Schemes (LOS) works the same way as the Table of Contents. When
you have finished your document, simply update the LOS in exactly the same way as the
Table of Contents. Always update the LOS before submitting to make sure that all
listings and page number references are accurate.
PLEASE NOTE: The List of Table, Figures and Schemes will populate the list
with the words “table”, “figure” and “scheme” on each line. The words need to
be deleted and can be done so by placing the cursor at the end of the word and
backspacing, or by doing a global find/replace as follows:
select the entire List of Figures
click on Replace (from the Home Ribbon)
In the “Find what: “ text box type “Figure “ (be sure to add one space at
the end of the word)
In the “Replace with:” text box insert the special character for Tab or
type “^t”
Click “Find Next” and “Replace” any entry of the word “Figure”. Do
not press “Replace All ”, as this may have unintended
consequences.
Other Preliminary Pages
You may have need for more preliminary pages such as List of Symbols, List of
Terms, List of Acronyms, etc. This will need to be added manually if needed.
Click just before the section break on the current last preliminary section
(usually List of Figures), Insert a “Section Break (Next Page)” On the
first line of the new section, select the style “Preliminary Page Heading”
and type your title for this section in ALL CAPS. Insert content for your
new preliminary page
10

CHAPTER IV
MAIN BODY
First Page of a Chapter
The first two chapters are pre-generated in the Templates. Note: DO
NOT DELETE “{TC "CHAPTER" \f C \l "1" \n}” after CHAPTER I
as this is what tells the Table of Contents to place the word “CHAPTER”
after the preliminary page entries. Simply alter the Chapter titles and begin
filling in the body.
Creating New Chapters
When you need to create a new chapter (beyond chapter II),
•

Click on a blank line after any content in the latest chapter

•

Insert a “Section Break (Next Page)”.

•

On the first line of the new section type “New chapter”and hit F3.
This will insert the word “CHAPTER” and the next chapter
number at the top of the page, already formatted and create a text
box to type in the chapter title (should be in all caps)

•

(Use Shift+Enter to force new lines so that multiple line titles are
in inverted pyramid format where each line is shorter than its
preceding line)

•

Insert content for your new chapter
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Headings
When you are ready to have a heading, simply type the title for the heading and
then apply the appropriate heading level style to it (1st through 5th level heading). This
will automatically space your subheadings appropriately, so you will not need to add
any blank lines manually. Note: heading levels may not be “skipped”. Headings
are like outline levels, so if you use a 3rd level heading, then there must exists
prior a 2nd level heading to which it relates (and a 1st level heading for which the
2nd relates).
Additional Instruction for Appendices Headings in Templates C, and C with
Schemes
In the appendices, you will need to use the Appendix heading styles so that
the appendix letter is included in heading numbering.
Additional Instruction for 4th Through 5th Level Headings in Template APA
APA formatting has 4th through 5th level headings as part of a paragraph.
•

Type out the heading and associated paragraph

•

Set the paragraph’s style to “Heading in Paragraph” (this sets up any
required spacing)

•

Select the part of the paragraph that is to become the heading

•

Once highlighted, click on the appropriate heading style (4th or 5th)
Headings should now be formatted to APA requirements and will
be picked up by the Table of Contents when updated.
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Inserting Tables
There are two ways to insert tables.
Inserting a table using QuickParts:
•

Type “New table” and hit F3. This will create a place to enter your table title, the
table and notes, if any.

Inserting a table using the Styles:
•
•
•
•
•

Create your table title by selecting the “Table Titles” style. The “Table Titles”
style will automatically have the correct spacing above and below the title.
For Template APA, press Shift+Enter before typing the title for your table.
For all other Templates, type the title for your table
It is highly recommended that you create short, concise titles and put all
detailed descriptions in a note section below the table.
On the next line, insert your table. Your tables should always be set for “In
line with text” for optimum control. Note, Word automatically puts extra
spacing on the left and right side of a table, which means that full width tables
(6”) will extend into the margins. To correct for this, either reduce the table’s
width to 5.9” and center the table.
To Create Notes:
•

Use the Style “Notes” on the next line down from the table (The
template will automatically select the Notes style after you hit enter
at the end of a line with the Table Title style). This will automatically
set up the spacing for after the table.

•

Place all detailed caption, notes, references, legend information, etc
here. Use Shift+Enter to force new lines as needed.

•

Leave blank if notes are not desired and press Enter to continue with
your document (Do not delete this line).

Tables that Span Multiple Pages
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First, only tables that are longer than one page in length may be split. Smaller tables
must be moved to avoid splitting, which may leave a large amount of blank space,
which is allowable in this circumstance.
If you have a table that spans multiple pages, then each page after the first must have
“Table # (Continued)” above that page’s section of the table.
To break a table at the top of a page
•

Click on the last row of the table where you want it split

•

Go to the Table Layout Ribbon

•

Click “Split Table”. Enter 2 or 3 times so that there is a cursor appearing
above the table on the next page.

•

Type the word “Table “with the correct table number and the
word“(Continued)” at the top of the new page

•

Set this line to the Table continued Style
Inserting Figures

There are two ways to insert figures.
Inserting a figure using QuickParts:
Type “New figure” and hit F3. This creates a line with the images style and a box
for loading images, then a line with the figure title style and a box for typing a figure title,
and finally a line with the figure notes style with a box for inserting figure notes
Inserting a figure using the Styles:
Creates a line with the images style and a box for loading images, then a line
with the figure title style and a box for typing a figure title, and finally a line with the
figure notes style with a box for inserting figure notes.
•

Set the format for the figure’s line to the “Images” style.

•

Next, insert your figure. Make sure your figure is not wider than 6”. It
is also recommended that you use an image type (jpeg, gif, png, etc.)
rather than objects (such as those created with drawing tools, excel
graphs, etc.), as you will be able to better control the layout and spacing
as your document changes and it will keep the file size to reasonable
14

•
•

limits. As with tables, your figures should always be set for “In line
with text”.
Create your figure title by selecting the “Figure Titles” style. The
“Figure Titles” style will automatically have the correct spacing above
and below the title.

•

It is highly recommended that you create short, concise titles and put
all detailed descriptions in a note section below the figure title.

•

Use the Style “Notes” on the next line down from the figure title (The
template will automatically select the Notes style after you hit enter at
the end of a line with the Figure Title style). This will automatically
set up the spacing for after the table.

•

Place all detailed caption, notes, references, legend information, etc
here. Use Shift+Enter to force new lines as needed.

•

Leave blank if notes are not desired and press Enter to continue with
your document (Do not delete this line).

Figures that Span Multiple Pages
First, only figures that are longer than one page in length may be split. Smaller
figures must be moved to avoid splitting, which may leave a large amount of blank
space, which is allowable in this circumstance.
If you have a figure that spans multiple pages, then each page after the first must
have “Figure # (Continued)” below that page’s section of the figure.
Type the word “Figure “with the correct table number and the word
“(Continued)” at the top of the new page
Set this line to the Figure continued Style
Place notes at the end of the figure section.

Inserting Schemes (Template C with Schemes only)
Schemes work exactly as inserting Figures in the previous section.
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Set the format for the scheme’s line to the “Images” style
Next, insert your scheme. Make sure your scheme is not wider than 6”.
It is also recommended that you use an image type (jpeg, gif, png,
etc.) rather than objects (such as those created with drawing tools,
excel graphs, etc.), as you will be able to better control the layout and
spacing as your document changes and it will keep the file size to
reasonable limits. As with tables, your schemes should always be set
for “In line with text”.
Create your scheme title by selecting the “Scheme Titles” style. The
“Scheme Titles” style will automatically have the correct spacing
above and below the title.
It is highly recommended that you create short, concise titles and put
all detailed descriptions in a note section below the scheme title.
Use the Style “Notes” on the next line down from the scheme title (The
template will automatically select the Notes style after you hit enter
at the end of a line with the Scheme Title style). This will
automatically set up the spacing for after the table.
o Place all detailed caption, notes, references, legend
information, etc here. Use Shift+Enter to force new lines as
needed.
o Leave blank if notes are not desired and press Enter to
continue with your document (Do not delete this line).
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Schemes that Span Multiple Pages
First, only schemes that are longer than one page in length may be split.
Smaller schemes must be moved to avoid splitting, which may leave a large amount of
blank space, which is allowable in this circumstance.
If you have a scheme that spans multiple pages, then each page after the first
must have “Scheme # (Continued)” below that page’s section of the scheme.
Type the word “Scheme“ with the correct table number and the word
“(Continued)” at the top of the new page
Set this line to the Scheme continued Style.
Place notes at the end of the scheme section.
Inserting Equations
Inserting an equation using QuickParts:
Type “Equation number” and hit F3. This creates an invisible table that creates a
line for the equation and also numbers the equation for you. Equations are either
numbered sequentially throughout the document or sequentially by chapter (must be the
same numbering style used for tables/figures). Equations lines may be set up using the
“equation” Style.
Inserting an equation using the styles
When ready to insert equation content set a blank line to the
Equation style
On the equation line press Tab
Insert your equation
press tab again and type in “(Eq. #)” (or any appropriate variant)
For multiple line equations, it is best to make the long equation into a single
image (following the requirements for lining up equivalency signs in multi-line
equations as specified in the Standards) and place that image after the first Tab. Any
desired sub numbering (ie. a., b., c., etc) should be part of the equation object, not the
main numbering of the equation. Ie. “(3a) (3b) (3c) etc” is not allowed. A, b, and c
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would all be parts of one main number, (3), and found by their respective constituent
parts within the overall numbered equation group.
Landscaped pages
Landscape pages may be formatted using Word: Go to Layout, Orientation, and
chose Landscape. You will need to place a “Next Page” break on the page before the
landscape page and a second “Next Page” break after all information on the
landscape page.
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CHAPTER V
ADA WEB ACCESSIBILITY
Beginning Spring of 2020, we will require all students to ensure their document is
Web-Accessible based on Federal Code, The Rehabilitation Act of 1973 Section 508.
We will be utilizing standards set forth by the World Wide Web Consortium (W3C) Web
Content Accessibility Guidelines (WACG 2.0).
Purpose
The purpose of having a web-accessible document is to provide everyone the
same opportunity to read your work. Web-accessible documents allow those with little to
no vision access to your document with the aid of screen readers or other visual aids.
Even if you will withhold your document to MSU only or even embargo it for a period,
you need to ensure your document is ready for the general public when it is released.
Requirements
As the author of a thesis or dissertation, you are required to add Alt text to all
tables, figures, schemes, and equations. We will discuss specific standards later in this
document. You will also find the standards in the official Standards document in the
Canvas module and on our website. You are also required to use one of the templates
created by the Office of ETD Formatting and Submissions. Finally, you are required to
perform an accessibility check and provide us with a copy of the report once you have
completed all of the fixes yourself. This document will guide you through those steps.
Technology
You will need access to Microsoft Word. If you do not already have a copy on
your computer, you have access to a free copy from University ITS.

19

University Operating Policy
MSU Operating Policy 01.13: World Wide Web Pages and Other Electronic
Publications is the policy upon which we will determine what will meet the requirements
of this document. You can find a copy of the policy using the link or the QR code below.
https://www.web.accessibility.msstate.edu/policy-standards
Helpful Tips
•
•
•
•
•

Add Alt Text as you work through your document. Then it won’t be a daunting to
complete the task
Ask questions as you go. Again, completing each small task as you go will save
you time in the end.
Make sure your tables, figures, or schemes are not text wrapped. The image
MUST be in line with the text to be considered acceptable
You MUST use a template. Using a template will help ensuring your document is
accessible.
Make sure you use the styles. This will help the PDF converter find a logical
order for accessibility.
Adding Alt Text to Figures, Schemes, Tables, and Equations

Alt Text to Figures and Schemes
•

After you have inserted your image, you right click and choose “Edit Alt Text”

•

When you click “Edit Alt Text”, a window will open to the right.

•

In the blank window, you will write you alternative text. Please refer to the
Standards for appropriate input. You will complete these same steps for inputting
Alt Text for Schemes.

•

If you had an image that was decorative, it was just there to look pretty and did
not serve a purpose, you would make sure you checked the “Mark as decorative”
box. This will tell screen readers to skip the image.
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Alt Text for Equations
•

You will need to use the “Equation number” Quickpart to create an invisible table
to insert your equation. The Quickpart will create a numbering system to match
your chosen template.

•

First, you will need to insert the equation quickpart by typing:

1. Equation number
2. F3
This will give you the image area and the equation number for your new equation.
•

You will then type your equation where it says, “Insert your equation”.

•

Next, you will highlight the entire table. When you hover over the table, you will
see a plus sign in the top left corner.

•

Click this to highlight the entire table.

•

Next, you will choose “Properties” in the “Layout” section of the “Table Tools”
tab.

•

Once you click “Properties” that will bring up a new window. You will click the
“Alt Text” tab.

•

That will bring up the section where you will enter the alternative text for your
equation.

•

In the title section, you will write “Equation” and then the number. In the blank
window, you will write “This equation is discussed on page xx. If you have any
questions, please contact the author.”

•

Click “OK” and that is all you need to do for the equations.
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Checking for Accessibility
Once you have added Alt Text for all of your figures, schemes, tables, and
equations, and you have connected all of your headings and titles to the correct style, you
will need to conduct a full accessibility scan of your Word document.
As long as you have input Atl Text as you worked through your document and
connected everything in the styles pane, you should have little issue with the accessibility
checker. For your Word document, Word has a built-in checker we will use.
Setting up Word for Accessibility Checks
•

You should be able to see “Check Accessibility” in the “Review” tab of Word.

•

If not, contact the office and we can walk you through getting access.

Conducting an Accessibility Check
•

You will need to click the “Check Accessibility” button on the “Review” tab.

•

Once you click the icon, a window will open to the right with all the issues you
may have in your document.
Errors : Figures, Schemes, and Equations

•

To fix the issues, you will just click the error, for the document we checked, you
would click “Picture 3” in the Accessibility Checker box. This will take you to
that image. You will then follow the Alt Text directions found on page 2. You
will need to do this for every error that is under the “Missing alternative text”
section.

•

If you get the message “Image or object not inline” that means you have that item
text wrapped. It could be a figure or a table. You will need to remove the text
wrapping to make your document compliant.
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Errors : Tables
•

You may have an error that reads “No header row”. You may come across this
error if you have a long table that is continued on another page. All you will need
to do is copy and paste the top row onto the next page after you split the table.
You can find directions to complete this task below.
Splitting Tables and Inserting New Header Row

•

Let’s say you have a table that starts on one page and ends on the second page.

•

You will need to split the table, copy and paste your title row, and make sure that
title row is a “Header Row”

Splitting Table
•

Highlight the top row on the second page or wherever you want the table to break.

•

This will open a “Table Tools : Design and Layout” tabs at the top of the
document.

•

Choose “Layout” and then choose “Split Table”

•

This will split the table for you. Next, you will title the continued table, Table
insert number (continued).

Next, you will want to make sure the first line of the table is a “Header Row”.
•

Highlight the top row of the table.

•

Go to the “Design” tab of the “Table Tools” section. Make sure the “Header
Row” box is checked.
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Inserting New Header Row
•

After you have checked the top row of the first table, you will need to copy and
paste that row to the “continued” table. You just need to complete the following
steps:
1.
2.
3.
4.

Highlight and copy the top information row
Click after the word “continued”
Hit the Enter once
Paste.

This should connect this information row to the “continued” table.
•

You will then highlight the top row, the one you just pasted, and make sure it is a
“Header Row”. You will do this just the same as above.

Final Notes: Microsoft Word Accessibility Checker
Before you publish your PDF, make sure you have adjusted the title in the
‘Advanced Properties”.
•

You can find these properties when you click “File”.

•

To the right, you will see “Properties”.

•

You will click “Properties” and it will provide a drop-down menu.

•

Once you have clicked “Advanced Properties” you will get this menu.

•

The Title will be the title of your thesis/dissertation. Make sure your name is
listed in the Author line. Those are the only two pieces that you need to make
sure you have completed. By doing this, it fix the “Title” issue in the PDF
Accessibility Checker.
Contrast

When creating graphs and charts, you need to make sure your color contrast and
line weight choices are distinct enough for users with color-blindness or low vision will
be able to read your info-graphic easily. The following are some examples of good and
bad graphs and charts.
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•

When selecting your color choices for your graphs, think about how they would
look if they were in black and white. Is there enough contrast difference between
the colors you chose that someone with color blindness would be able to
distinguish between the colors?

•

When selecting your color choices for your line graphs, thing about how they
would look if they were in black and white. Is there enough contrast difference
between the colors you chose that someone with color blindness would be able to
distinguish between the colors?

•

The best line graphs will consider color contrast as well as line styles. Keep this
information in mind as you create your charts and graphs. If your contrast is not
different enough, you can change the line styles to make it more acceptable.
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CHAPTER VI
REFERENCES
Reference Section
The References page is pre-formatted. Change the title from “References” if
desired. Finally, replace default text with your actual references. The only format
requirements are that each entry is single-spaced, that there is 1 blank line between
each entry, and that the referencing style used is consistent.
EndNote
Users of EndNote’s Cite While you Write will notice that EndNote places
their bibliography at the end of the entire document instead of the place required by
MSU.
Simply highlight the entire Bibliography generated by EndNote
Press Control+X to cut (or right-click and select cut)
Navigate to the provided Reference section in the template
Use Paste-Special (Formatted Text) to past EndNote’s linked Bibliography
Zotero
Users of Zotero should be able to drag and drop their Bibliography into
the provided Reference section.
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Multiple Reference Sections (at the End of Each Chapter)
If you are required to place references at the end of each chapter, then remove
the default reference section provided (deleting all text and the “Section Break (Next
Page)”). Start your reference sections on new pages at the end of each chapter and use
the “1st level subheading” style for your reference heading.
For most automated citation software, you should only need to make one
change in Word so that bibliographies are created at the end of each chapter:
•

Click on the references tab

•

On the references ribbon, to the right of the word “Footnotes” in the
Footnotes section, click the small pop out box (bottom right corner
of this section)

•

In the Footnotes and Endnotes window, click “Endnotes” and select
“End of Section”
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CHAPTER VII
APPENDIX
There is a pre-generated appendix in the Templates. Note: DO NOT DELETE
“{TC "APPENDIX" \f C \l "1" \n}” after APPENDIX A as this is what tells the Table
of Contents to place the word “APPENDIX” after the main body entries. Change the
titles accordingly (similar to chapter titles).
To create a new Appendix Cover Page
•

Create a Section Break (Next Page) at the end of the previous
Appendix section.

•

Create two(2) blank lines (using Hard Returns)

•

Insert another Section Break (Next Page).

•

Go back to the first line created on the previous blank page and select the
style “Appendix Numbers”. This will place the word “APPENDIX” and
the next available letter.

•

On the second (last) line, set the style for Appendix Titles.

•

Type in your title, following the same guidelines for chapter titles.

•

Go to the page layout Ribbon, and select Margins->Custom Margins.

•

Click on the “Layout” tab in the newly opened Page Setup window

•

Set the “Vertical alignment” to “Center”.

You are now free to continue on to the next blank page and fill out the new
appendix section.
Appendix Headings for Templates C and C with Schemes
In the appendices, you will need to use the Appendix heading styles so that
the appendix letter is included in heading numbering.
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Use “Appendix 1st level heading” style instead of “1st level heading”
Use “Appendix 2nd level heading” style instead of “2nd level heading”
Use “Appendix 3rd level heading” style instead of “3rd level heading”
Use “Appendix 4th level heading” style instead of “4th level heading”
Use “Appendix 5th level heading” style instead of “5th level heading”
Appendix Tables/Figures/Equations for Templates APA, B, C, and C with Schemes
In the appendices, you will need to use the Appendix Table/Figure/Equation
styles so that the appendix letter is included in numbering. Other than the specific
style used for formatting, inserting Tables/Figures/Equations in the appendices works
as previously described in the chapter.
Use “Appendix Equation” style instead of “Equation”
Use “Appendix Table Title” style instead of “Table Title”
Use “Appendix Table Notes” style instead of “Table Notes”
Use “Appendix Table continued” style instead of “Table continued”
Use “Appendix Figure Title” style instead of “Figure Title”
Use “Appendix Figure Notes” style instead of “Figure Notes”
Use “Appendix Figure continued” style instead of “Figure continued”
Use “Appendix Scheme Title” style instead of “Scheme Title”
Use “Appendix Scheme Notes” style instead of “Scheme Notes”
Use “Appendix Scheme continued” style instead of “Scheme continued”
Content page for appendix
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CHAPTER VIII
PREPARING TO SUBMIT
Finishing touches
First, scroll through your document and make sure that the page numbering
is consistent and does not restart or skip values.
With paragraph marks turned on, you should see the text “Hidden test to
allow template to find last page in document” on the last page of your document. If
this is missing, manually type in the last page number found in the document by
“Pages in Study” in the abstract.
Update the Entire Document
The Table of Contents (TOC), List of Tables (LOT), and List of Figures (LOF)
should be updated after all content has been entered. The TOC may need to be updated
twice if either the TOC or the LOT is greater than 1 page. Basically, the TOC generates
its page number references based on the current position of headings in the document.
So while, initially, a LOT may be on page “v” on the first update, it may get moved
further down by a number of pages equal to the extra pages beyond the first that the
final updated TOC becomes. Once the size of the TOC, LOT, and LOF is established
through the first updated, it should be a simple matter of just updating the page
numbers.
The fastest way of updating is:
•
• Press Control +A to select the entire document
•
•
•

Right click and select “Update Field”
Click through the various dialog boxes to update the entire document
After updating go through the document to make sure there are no broken
links. Such will have the text “ERROR! Bookmark not found!”.
Update the document again after repairing any such links.
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Copying and pasting into the templates
If you have already written some or the majority of your work before using
these templates, you can copy and paste your work into the templates, but do so a
small section at a time, making sure to link the corresponding style to each section so
that the table of contents, list of table and figures, etc. will populate correctly.

31

CHAPTER IX
QUICKPARTS

Quickparts are a convenient way for storing reusable content that can be
accessed quickly by: Typing the name of the Quickpart desired and hitting F3
Quickparts in All Templates
Appendix Equation:
For use in Appendices. Places a new line with the Appendix Equation style with
a tab, placeholder box for equations, another tab, then SEQ field code for equation
numbering.
Appendix Figure:
For use in Appendices. Creates a line with the images style and a box for loading
images, then a line with the figure title style and a box for typing a figure title, and
finally a line with the figure notes style with a box for inserting figure notes.
Appendix Table:
For use in Appendices. Creates a line with the Appendix Table Title style and a
box for typing the table title, then an example table to be replaced, then a line set to the
table notes style with a box for inserting table notes.
Double approval page entry:
For use on the Approval Page. Creates two columnar entries, side by side,
including 2 signature lines, 2 content boxes for committee member name and 2 drop
down boxes for committee role.
Equation:
Places a new line with the Equation style with a tab, placeholder box for
equations, another tab, then SEQ field code for equation numbering.
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Figure:
Creates a line with the images style and a box for loading images, then a line
with the figure title style and a box for typing a figure title, and finally a line with the
figure notes style with a box for inserting figure notes.
New appendix:
For use in creating new appendices after the prebuilt appendix A. Adds a section
break to end the previous appendix, then a line with the style Appendix Title and a box
for entering the title. Then adds another section break and centers the page vertically.
Finally it adds a few blank lines to begin the new appendix’s content.
New chapter:
For use in creating new chapters after the prebuilt chapter II. Adds a section break to
end the previous chapter, then a line with the style Chapter Title and a box for entering
the title. A few extra blank lines are added to begin the new chapter’s content.
Scheme:
For use in Template C with Schemes. Creates a line with the images style and a
box for loading images, then a line with the Scheme Title style and a box for typing a
scheme title, and finally a line with the Scheme Notes style with a box for inserting
scheme notes
Single approval page entry:
For use on the Approval Page. Creates a centered entry set including a signature
line, a content box for committee member name and a drop down box for committee role.
Table:
Creates a line with the Table Title style and a box for typing the table title, then an
example table to be replaced, then a line set to the table notes style with a box for inserting
table notes.
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Additional Quickparts Reserved for Repairing Broken Templates
The following Quickparts make it possible to completely rebuild the original
content of the template. It is recommended that consultation with the Office of Thesis
and Dissertations be sought before using these Quickparts.
Rebuild abstract:
Creates a copy of the original template abstract, including section break.
Rebuild acknowledgements:
Creates a copy of the original template Acknowledgements, including section
break.
Rebuild appendix a:
Creates a copy of the original template Appendix A divider page..
Rebuild approval page:
Creates a copy of the original template Approval Page, including section break.
Rebuild chapter 1:
Creates a copy of the original template Chapter I, including section break.
Rebuild copyright page:
Creates a copy of the original template Copyright Page, including section break.
Rebuild dedication:
Creates a copy of the original template Dedication, including section
break.
Rebuild list of figures:
Creates a copy of the original template List of Figures, including section
break.
Rebuild list of schemes
Creates a copy of the original template List of Schemes, including section break.
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Rebuild list of tables:
Creates a copy of the original template List of Tables, including section
break.
Rebuild table of contents:
Creates a copy of the original template Table of Contents, including section
break.
Rebuild title page:
Creates a copy of the original template Title Page, including section break.
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